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Understanding the Network
Management Card (NMC)
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Figure 1.  Chassis Management

The Network Management Card (NMC) manages all of the cards in the
Total Control chassis.  Commands are sent to the NMC from the PC
running the console software (referred to as the Management Station).
Two protocols are used to implement these management functions:  one
between the NMC and the Management Station, and a second between
the NMC and the managed devices.
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SNMP Communication
The NMC communicates to the Management Station (MS) by way of the
Simple Network Management Protocol (SNMP).  Since the individual
Network Application Cards (NACs) in the chassis are not necessarily
running SNMP agent software directly, the NMC performs as a proxy
agent.  This means that the NMC receives requests from the MS that are
articulated using MIBs (Management Information Bases) that have been
defined for each card in the chassis.  The NMC then carries out the
requests and obtains results using a proprietary U.S. Robotics protocol,
and returns the results to the MS, again using SNMP.  Standard SNMP
traps can be enabled to send a trap message (or event notification) to one
or more Management Stations.  The Management Station uses these
traps to create logs and trigger alarms.  (See Setting Traps later on.)

Management Bus Protocol Communication
The NMC communicates to each of the installed cards using the U.S.
Robotics proprietary Management Bus Protocol (MBP).  The NMC
provides configuration management for each of the Network Application
Cards (NACs) in the chassis, which means it has the ability to set each of
the parameters for a NAC to desired values.  This includes a feature to
allow automatic configuration of those parameters to predetermined
values upon insertion of the NAC into the chassis.  (See Saving
Configurations later on.)  As an aid to configuration management, the
NMC can also query the current value of the parameters for each NAC,
and download software for upgrades.

NMC IP Addresses
In order for Total Control Manager/SNMP to establish a connection with
the NMC and discover the configuration of the chassis, you must enter
an IP address in the software to identify the NMC.  Default addresses are
assigned to both the LAN (192.77.203.193) and WAN (192.77.203.65)
ports on the NMC NIC.  Although these defaults can be used for initial
connection, we strongly suggest that these addresses be changed during
your first session to match your local internetworking scheme.  NMC IP
addresses can be changed from either the local RS-232 User Interface or
the management software.  See the Network Management Card Reference
Manual or the Total Control Manager/SNMP Software Guide for more
information.
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Ordering a T1 Line

The following are some features you should keep in mind when ordering
a T1 line from the telephone company (TELCO).

T1 Service Type
You must order a switched (channelized) T1 service.  With a switched
service, each DS0 of the T1 span line carries the digital representation of
an analog phone line.

Trunk Types / Start Supervision
Loop Start, Ground Start, and E&M trunk types are supported.  Loop
Start and Ground Start trunk types use the Dial Tone start method, and
use only DTMF signaling.

NOTE:  Loop  Start and Ground Start are supported only by Quad V.34
modems.

E&M trunks use either Wink Start or Immediate Start methods, and can
use either MF (Multi-Frequency) or DTMF (Dual Tone Multi-Frequency)
signaling.

The following table indicates the T1 line provisioning options that are
currently supported.

Table 1.  Supported Provisioning Options

Trunk Type Start Method Tone Signaling

E&M Wink or Immediate MF or DTMF

Loop Start Dial Tone DTMF

Ground Start Dial Tone DTMF

Because Loop Start and Ground Start trunks require DTMF signaling,
they do not support receiving any address information (DNIS or ANI)
that may be sent by the telephone company Central Office on dial-in
calls.  To remedy this, additional parameters must be set for the modem.

E&M Type II Signaling
E&M (Ear and Mouth) is the traditional type of TELCO call signaling for
an analog call.  It specifies the wires that provide the signaling paths
between the TELCO and the customer’s equipment.  E&M Type II
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signaling defines how the TELCO modulates the A andB signaling bits to
convey call set-up and tear-down information.

Wink Start / Immediate Start
A wink is the transition from on hook to off hook, and back to the on
hook state.  The use of Wink Start Supervision avoids glare.  Glare occurs
when there is a simultaneous seizure on both ends of a two-way trunk.

With Immediate Start trunks, no wink is returned in response to trunk
seizure.  This leads to slightly faster call setup.  However, since no trunk
integrity checking is performed, Immediate Start is recommended only
when Customer Premises Equipment (CPE) does not support Wink Start.

Loop Start
Loop Start was originally developed on analog lines, then converted to
digital lines.  It is the most common line type available, and is used in
most residential lines to provide supervisory and start signals.  In an
analog Loop Start trunk, there are two conductors:  tip and ring.  All
signaling involves current flow through these two conductors, which
forms a current loop with the network.  Once the network detects current
flow in the loop, it sends a dial tone as a start signal.

Loop Start is translated to the digital T1 carrier by using the A and B
signaling bits.  The transmitted bits tell the network whether the loop is
open or closed.

NOTE:  Loop Start lines are very susceptible to glare.  They should only
be used as one-way lines (either dial-in or dial-out).

Ground Start
Ground Start is a little more robust than Loop Start.  It was also
originally developed for analog lines and converted to digital.  Ground
Start trunks have the most complex signaling protocol of the trunks
supported.  The A and B signaling bits on the T1 line are used to mimic
the tip and ground connectors in the analog world.  Ground Start trunks
are often preferred to Loop Start trunks because the network provides
additional signals for alerting, starting and ringing.

Like a Loop Start line, Ground Start lines use both a ring and a tip
conductor.  However, the network can not only detect current flow
through the ring and the tip, but also detect whether the tip or the ring
has been grounded.  This configuration allows Ground Start lines to
convey more signaling information over the line.  It also makes Ground
Start supervision somewhat of a complex protocol.

Total Control performs Ground Start in the digital world by mimicking
analog signals.  The T1 Card uses the A and B signaling bits to send a
busy-out pattern (0,0) to the TELCO.  We believe that this busy-out
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signaling pattern is appropriate for the majority of cases.  However, not
all Regional Bell Operating Company switches treat this pattern in the
same manner.  If your installation experiences any difficulty with this
feature, contact U.S. Robotics Technical Support at (800) 231-8770, and we
will work with you to find an appropriate solution.

NOTE:  USR Ground Start and Loop Start support Station signaling
only, not Office signaling.

Tone Signaling (Dialed Digits)
The T1 Card supports DNIS and ANI digits sent using standard Multi-
Frequency (MF) tones.  MF signaling provides 15 two-frequency
combinations.  MF signaling supports KP (Key Pulse) and ST (Stop)
control signals, which facilitate the transmission of ANI and DNIS digits
by indicating when the transmission of an ANI or DNIS number begins
and ends.  The modem decodes the MF tones and then acts on any ANI
or DNIS digits embedded in the signaling.

DTMF Signaling
The T1 Card also supports Dual-Tone Multi-Frequency (DTMF) tones
when operating with a properly configured compatible modem.  DTMF
signaling is the same as Touch Tone; it uses 12 distinct signals over the
voice path to provide addressing information (0−9, *, #).  This addressing
method is slightly more limited than is possible with MF signaling, but is
required for Loop Start and Ground Start trunk types.

Direct Inward Dialing (DID)
Direct Inward Dialing allows direct access to a PBX line from a line
outside of the PBX.  It requires the telephone company Central Office to
transmit the address of the station being dialed (usually four digits).

On PBXs, when a DID call comes in it is routed to a PBX station
corresponding to the number dialed.  The T1 Card always routes the
dial-in call to the Quad Modem assigned to the DS0 the call came in on.
A user can assign any DS0 to any Quad Modem.

Most DID trunks are E&M trunk types, and use Wink Start with DTMF
signaling.  The Quad Modems support DTMF tones to enable this
feature, and E&M and Wink Start can be selected as Call Parameter
Configuration parameters for the T1 Card.

Answer Supervision
On receipt of the M-Lead Wink from the T1 Card, the TELCO begins
sending Multi-Frequency (MF) Tones, which represent the dialed phone
number.  Once the T1 Card receives the MF Tones, it answers the call by
going off hook (M-Lead Off hook).
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Frame Type
The Super Frame (SF) format, also known as D4 framing, has 12 DS1
frames, each with 193 bit positions.  The first bit is the frame overhead-bit
position, which is used for frame and signaling phase alignment.

The Extended Super Frame (ESF) format has 24 DS1 frames:  the ESF
alignment signal and a Cyclic Redundancy Check (CRC) share the frame
overhead-bit position.

Line Coding
A line coding scheme ensures a sufficient density of 1’s in the bit stream,
required by the T1 standard for clock synchronization.  The T1 software
supports Alternate Mark Inversion (AMI), Zero Code Suppression (ZCS),
or Binary 8 Zero Substitution (B8ZS).

Feature Group B DNIS Support
The T1 Card can make use of the Feature Group B (FGB) DNIS (Dialed
Number Identification Service) feature, which is offered by most
TELCOs.  The FGB DNIS requires a telephone number exchange of 950;
the other four digits in the number can be linked with configuration
information for a modem.  At the beginning of an incoming call, if DNIS
is enabled, the TELCO provides the phone number that was dialed.  The
Quad Modem cards can use this information to provide a specific
configuration, or to route the call to a specific Gateway card.  If your dial-
up application could benefit from the use of DNIS numbers, order this
service from the TELCO and select DNIS for the Dial-In Address.

Feature Group D ANI and DNIS Support
Feature Group D (FGD) supports an expanded DNIS feature, in which all
seven digits of a phone number (or ten, including the area code) can be
linked with configuration information.  It also supports ANI (Automatic
Number Identification), which identifies the calling number and uses it in
a similar way.  With FGD, you can select either DNIS, ANI, or ANI-DNIS
for the Dial-In Address parameter.

CSU Interface
The T1 NIC’s CSU interface supports a DS1 signal.  This interface can
recover T1 signals through a 6000 foot cable.

RECOMMENDED:  Connect the T1 NIC’s interface directly to the
TELCO’s Smart Jack interface.
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Installing the Software

System Requirements

Hardware
The minimum hardware configuration required to run Total Control
Manager/SNMP software  is as follows:

♦ 80486-based IBM PC/AT or compatible, 33MHz

♦ 16 Mbytes RAM

♦ VGA graphics adapter and monitor

♦ 3.5-inch, 1.44-Mbyte floppy drive

♦ Mouse supported by Windows 3.1

♦ 40-Mbyte hard drive with 20 Mbytes free

♦ Serial communication adapter card with 16550 UART (required for
port speeds above 19.2K bps)

The following is recommended:

♦ Dedicate one PC as your Management Station, and a different PC as
your Security/Accounting server

♦ 80486-based IBM PC or compatible, 66MHz

♦ Super VGA graphics adapter and monitor

♦ Resolution setting of 800x600 with 256 colors

NOTE:  As with all other Windows programs, lower screen
resolutions and certain screen fonts may slightly alter the
appearance of the Total Control Manager/SNMP window, but the
menu items remain completely functional.

♦ 120-Mbyte hard drive with 60 Mbytes free

♦ 16-bit Network Adapter (Token Ring only)

♦ RS-232 Serial Communications Port with 16550 UART
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Software
The following software components are required to run the Total Control
Manager/SNMP software:

♦ DOS 5.0 or higher

♦ Windows 3.1

NOTE:  Total Control Manager/SNMP is not supported by Windows
NT and Windows 4.0.

♦ The Novell NetWare Management System (NMS) SNMP host
software.

NOTE:  U.S. Robotics provides NMS 1.15B along with the TCM
software and does not guarantee operation with any other version of
NMS.

♦ ODI Device Driver

Preliminary Steps
Be prepared with the following information:

♦ The IP address for your workstation

♦ The IP subnet mask

♦ The IP address (default gateway) of an IP router (if any)

♦ The location of the NET.CFG file on your PC (if one exists)

♦ The type of network adapter installed in your system (if any)

DOS Preparation
1 The DOS program SHARE.EXE must be running on the PC that you

intend to use as your management station.  Either add it to your
AUTOEXEC.BAT or type SHARE from the DOS prompt.

2 Start Windows.
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Installing the NetWare Management System

1 Insert the NetWare Management System Setup disk in your
Management Station’s floppy drive and run SETUP from Windows.

2 You are initially prompted to indicate which NetWare components
you want to install.  Click on the box to include the NetWare
Management Map only.  Be sure that no other boxes are checked.

NOTE:  If you are connected to a NetWare server and are installing
NMS for the first time, this prompt will also include four other
installation options:  TCP/IP, NetExplorer, NetExplorer Plus, and
NetWare 3.11 SNMP update software.  These four install options
may appear with a checked box in front of them in the prompt
window.  Click on the boxes to remove the “X” before you proceed.

If you leave these options checked, you will be prompted at the end
of the installation for a Disk 5 that is not included with your
software, and the installation will fail.

3 You are then prompted for network registration information.  Enter
the administrator name and company name.

4 If connected to a network, the next prompt is for the size of the
network.  Specify whether there are under 100 nodes, between 100
and 1000, or over 1000.

5 Continue the installation, replacing disks 1-4 in the floppy drive as
requested.

6 After you insert disk 4, you are prompted for a Network Adapter
name.  Select the Other option at the bottom of the window.  This is
especially important if you intend to make a SLIP connection
between the PC and the chassis.

7 The Install program then asks for the location of certain network files.
You do not need to complete this information.  Click on the OK
button at the bottom of the window.

8 The Install program may encounter incompatible network files.  Click
on OK to continue past these messages.
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9 You are prompted to select a time zone, and to indicate whether or
not daylight savings time is in effect.

10 The Install program asks to modify your system files (SHELL.CFG,
CONFIG.SYS, AUTOEXEC.BAT, SYSTEM.INI, and WIN.INI).
Confirm these changes as you are prompted.

11 You are then prompted for a server name.  Leave the field blank and
click on OK.

12 The Install program then prompts for Disk 4.  This disk should
already be in the floppy drive.  However, a bug in the Install
program proposes the directory name where the files are being
installed instead of the floppy drive name.  Delete the directory name
and replace it with the floppy drive name where the disk is loaded,
then press Enter.

This completes the Novell portion of the Install.  Review the Novell
readme file, then close it to proceed with the USR installation.

Installing Total Control Manager/SNMP

IMPORTANT:  Before starting the installation of the USR software, be
sure that all NetWare Management Map (NMM) components are
closed.

1 Insert the Total Control Manager/SNMP Setup Disk in your
Management Station’s floppy drive and run SETUP from Windows.

2 When prompted, insert the second disk.

3 A prompt will ask if you want to add the TCM program icons to the
NMS program group.  Click on Yes.

4 The Install program finishes and places TCM executable and readme
icons in the NMS program group.  Review the readme file.

5 Exit Windows, then restart it.
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Installing Extra Options
U.S. Robotics offers some added-cost options that may be installed along
with Total Control Manager/SNMP:  Auto Response, Security, and Cellular
options.  These extra options consist of two upgrade components:  one
for the NMC and one for TCM.

NOTE:  All NMCs built since the NMC 3.1 release are enabled at the
factory for the Auto Response feature.  If you have an NMC at release
level 3.1 or higher and want only to enable Auto Response, the TCM
upgrade is all you require.

♦ Each NMC that is intended to support the extra option must have the
feature enabled on it.  If you are installing a new NMC with an added
cost feature, it should have been enabled for you at the factory.  If
you wish to upgrade an existing NMC, see instructions for this under
Feature Enable in the Total Control Manager/SNMP Software Guide.

♦ Each installation of TCM must also be upgraded.  After finishing the
TCM installation, insert any disks for extra options and run SETUP
to enable them.

The Security feature requires Microsoft Open Database Connectivity
(ODBC) software.  A second disk is provided with this software.

Security ODBC Installation
The second disk that comes with the Security feature contains Microsoft
Open Database Connectivity (ODBC) software needed to maintain the
security database.

1 Insert the floppy into the drive and type drive:\SETUP (substituting
the letter of the drive).  The ODBC Setup utility title screen appears.

2 Click on Continue.  The Install Drivers window appears.

Figure 2.  Install Drivers Window
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As shown in the figure, there should be only one option in the list of
Available ODBC Drivers:  Access Data (*.mdb).

3 Select the Access Data option from the list of Available ODBC
Drivers and click on OK.  Files are copied to your \windows\system
directory.  Then the Data Sources window appears.

4 Click on Add.  From the list of Installed OBDC Drivers, select the
Access Data (*.mdb) option, then click on OK.  You are returned to
the Data Sources window,  and the Setup window appears.

5 Click on Cancel, then click on Close in the Data Sources window.
The utility will report a successful installation.

Installation Adjustments

Removing Novell Prompts
NMS installation initializes WIN.INI so that certain messages appear
each time you start Windows:  a prompt to start NetExplorer Manager,
and a NetWare error if you are not connected to a server.  You do not
need NetExplorer to run TCM and both messages may become irritating
if they occur each time you start Windows.  Follow these steps to turn
them off.

1 Open WIN.INI and find the LOAD= statement.

2 Leaving intact the LOAD= portion of the statement, delete the
filenames NMSCRON.EXE and NWPOPUP.EXE.

3 Restart Windows.  The messages will no longer appear.
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Editing SYSTEM.INI
There are two adjustments to be made to the SYSTEM.INI file.

Port Reinitialization
To prevent Windows from reinitializing COM ports used for SLIP
connections, we recommend editing the SYSTEM.INI file.  All references
to COM ports in the [386Enh] section should be remarked out using a
semicolon, as shown below:

[386ENH]
;COM1BASE=03F8
;COM1IRQ=4
;COM1AUTOASSIGN=2

NOTE:  Do not access the Advanced Settings in the Windows 3.1
Control Panel Ports application.  Exiting the window automatically adds
COMxBase= and COMxIrq= lines back into your SYSTEM.INI.

Novell Server Connection
If you do not plan to connect to a Novell server, remark out the
Network=VIPX.386 statement from the [386ENH] section of the
SYSTEM.INI file.

Compiling MIBs/Integrating Alarms
TCM does not automatically compile the MIBs that have been added for
each new release of software when you install.  You must perform the
following steps to compile the MIBs.

1 After upgrading the TCM software, download the new NMC
software, either via the pcsdl command or through TCM procedure
described in the Software Download Summary accompanying the disks.

2 Copy all the files on the second NMC diskette (Enterprise MIB
Extensions) except for CHS_TRAP.MIB into
C:\NMS\SNMPMIBS\ALLMIBS.

3 Review the USRMIBS.TXT file.  This file contains descriptions of the
MIBs provided by U.S. Robotics.

4 Copy only those MIBs you require into C:\NMS\SNMPMIBS\
CURRENT.

5 Copy CHS_TRAP.MIB into C:\NMS\SNMPMIBS\TRAPMIBS.
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6 Open the Novell NMS.  From the Tools menu, select SNMP MIB
Compiler.  A warning box will indicate that all the MIBs in the
C:\NMS\SNMPMIBS\CURRENT directory are about to be
compiled.  Click on Yes to continue.  You will now be able to use the
NMS MIB Browser.

7 When the compile is done, select SNMP Alarm Integrator from the
Tools menu.  Change to the C:\NMS\SNMPMIBS\TRAPMIBS
directory.

8 Select CHS_TRAP.MIB, and click OK.  A prompt appears asking if
you want to continue.  Click on Yes.  After performing integration, a
message appears indicating that the trap definitions were integrated
successfully.  The SNMP Alarm Integration window appears.  Click
on Cancel.

NOTE:  There are a limited number of MIBs that can be compiled in
NMS at one time.  If you encounter an error when compiling MIBs,
delete all but the necessary MIBs from the C:\NMS...CURRENT
directory and try again.

Change Required for Accounting/Event Logging
The Accounting/Event Logging feature is based on RADIUS, a public
domain client-server protocol.  The NMC runs the RADIUS client and
forwards customizable data to a server whose location you specify.  To
function correctly, you must register this feature as a TCP/IP Service
after the automated installation is complete.  Registration is not
automatically performed during installation because you may already
have a SERVICES file, and its location on a Management Station may
vary.

♦ If you already have a TCP/IP SERVICES file, add the following line
to the file:

RADACCT   1646/UDP

Exit Windows and reboot your computer so that your system
recognizes the new TCP/IP service.  Remember to reload your
protocol stack before starting Windows.

♦ If you do not already have a SERVICES file, we have provided a
sample for you to use:  \NMS\BIN\NET\SERVICES.SMP.

1. Create a directory to hold the TCP configuration files, such as
C:\NET\TCP.
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2. Using the name of the directory you created, add the following
line to your NET.CFG file:

PATH TCP_CFG   c:\net\tcp

3. Copy \NMS\BIN\NET\SERVICES.SMP to your TCP directory,
giving it the name SERVICES (no extension).

4. Exit Windows and reboot your computer so that your system
recognizes the new TCP/IP service.  Remember to reload your
protocol stack before starting Windows.

Change Required for Security
Security also uses the RADIUS-based client-server structure to store data.
As with the Accounting/Event Logging feature, you must register the
Security server in the TCP/IP SERVICES file.  Follow the steps in the
previous procedure, adding the following line to the SERVICES file:

RADIUS   1645/UDP

The Security feature restricts access to the server to certain Clients, which
are allowed to use the authentication services.  These Clients may be set
in the Security Manager application, and are typically USR NMCs and/or
NETServers.  You may specify an authorized set of Clients, by either
specific IP address or common name, as follows:

♦ If you already have a TCP/IP HOSTS file, add the following line to
the file, using values that you have specified in the Security Manager:

[IP ADDRESS]   [COMMON NAME]

Ensure the HOSTS file includes all USR NMC and NETServer IP
addresses, and associated Common Names, for all Clients that will be
authorized to use the authentication service.

Exit Windows and reboot your computer so that your system
recognizes the new TCP/IP SERVICES and HOSTS files.  Remember
to reload your protocol stack before starting Windows.

♦ If you do not already have a HOSTS file, we have provided a sample
for you to use:  \NMS\BIN\NET\HOSTS.SMP.

1. Create a directory to hold the TCP configuration files, such as
C:\NET\TCP.

2. Copy \NMS\BIN\NET\HOSTS.SMP to your TCP directory,
giving it the name HOSTS (no extension).

3. Edit the sample file to reflect your IP addresses and names.

4. Exit Windows and reboot your computer so that your system
recognizes the new TCP/IP SERVICES and HOSTS files.
Remember to reload your protocol stack before starting Windows.
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Software Installation Tips and
Troubleshooting

Problem You are prompted for disk 5 during installation and there
is no disk 5.

Solution During step 4 of the Install instructions you left an X in
the check boxes for NetExplorer, NetExplorer Plus, and
NetWare 3.11 SNMP.  Follow the Uninstall procedure in
the next section and then reinstall, making sure all X’s
have been removed from these boxes before proceeding.

Problem After the NMS is installed successfully, the USR
installation fails.

Solution Be sure that all NetWare components are closed before
proceeding with the USR installation.

Problem There is no “NEW USR DEVICE” option within the NMS
File Menu after installation.

Solution SHARE was not loaded when you installed Total Control
Manager/SNMP.  Load SHARE and reinstall the software.

Problem You receive an error message when entering Windows:

VTCPIP NO TCPIP PROTOCOLS LOADED

Solution Exit Windows and load the drivers per the examples
provided in the Loading Network Drivers section of this
guide.

Problem You receive an NWPOPUP error on starting Windows.

Solution Edit the WIN.INI file and remove the filename
NWPOPUP.EXE from the LOAD= line.

Problem VIPX error on starting Windows.

Solution This is generated when the IPXODI driver is not loaded
and you try to connect to a Novell server.  If you do not
plan on connecting to a Novell server, you can remove
VIPX.386 from SYSTEM.INI.

Problem You want to re-install NMS and TCM.

Solution First, follow the Uninstall procedure described in the next
section; then re-install NMS and TCM using the
instructions in this guide.
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Uninstalling NMS and TCM
You have several opportunities during software installation to abort.  If
you complete the installation, recognize a problem, and decide to start
over, you should uninstall the software before attempting to re-install it.

1 During installation, you allowed the software to overwrite system
files (SHELL.CFG, CONFIG.SYS, AUTOECEC.BAT, SYSTEM.INI,
and WIN.INI).  The system saved the old files with the file extension
.NMS (SHELL.NMS, CONFIG.NMS, etc.).  Rename the .NMS system
files so they overwrite the files loaded by NMS (e.g., rename
CONFIG.NMS as CONFIG.SYS, etc.).

2 Locate the NMS directory (C:\NMS\, unless you specified another
location during the installation procedure).

3 Delete the NMS directory and all its contents.

4 Delete the NMS group from the Windows Program Manager.

5 Exit your Windows session.

6 At the C:\ prompt, type the following command to locate any
remaining NMS files:

DIR /S NMS <ENTER>

7 Delete any NMS files located.

8 Reboot your computer.
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Customizing the NET.CFG File

In order for a PC to send management data to the NMC in the Total
Control chassis, a NET.CFG file must be customized to load the TCP/IP
stack and set link parameters for the PC port that will communicate with
the chassis.  This connection may be via direct cabling, over a LAN, or by
remote connection through a modem.

When Total Control Manager/SNMP is installed, two sample NET.CFG
files are placed into the C:\NMS\BIN\NET directory.  These files
provide a sample structure for setting SLIP_PPP, link support, and
TCP/IP protocol parameters.

The sample SLIP_C1.CFG file is for a connection made through COM1 of
the Management Station, and SLIP_C2.CFG shows a COM2 connection.
You may use either one of these files as a model and edit your own
NET.CFG file, customizing it for your IP addressing strategy.

Regardless of which method you plan to use for connecting to the
chassis, follow these instructions for editing the file.

1 Under the Link Driver section, be sure to insert the correct
Management Station port information (baud rate, port address,
interrupt).

2 Under the Protocol TCPIP section, edit the IP address, subnet mask,
and router address (if applicable) to reflect the addressing at your
installation.

3 Rename the file to NET.CFG.  Either leave the file in
C:\NMS\BIN\NET, or move it to another \NET directory you have
created on the PC.

If you move the NET.CFG file to another directory, remember also to
move all the other files that are located in the C:\NMS\BIN\NET
directory along with NET.CFG.
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Sample NET.CFG Files

SLIP_C1.CFG
Link Driver SLIP_PPP

DIRECT YES
BAUD 9600
OPEN ACTIVE
TCPIPCOMP VJ
PCOMP YES
ACCOMP YES
PORT 3F8
INT 4
FRAME SLIP

Link Support
Buffers 8 1500
MemPool 4096

Protocol TCPIP
# ip_router 192.77.203.?

ip_netmask 255.255.255.0
ip_address 192.77.203.66
tcp_sockets 8
udp_sockets 8
raw_sockets 1
nb_sessions 0
nb_commands 0
nb_adapter 0
nb_domain

SLIP_C2.CFG
Link Driver SLIP_PPP

DIRECT YES
BAUD 9600
OPEN ACTIVE
TCPIPCOMP VJ
PCOMP YES
ACCOMP YES
PORT 2F8
INT 3
FRAME SLIP

Link Support
Buffers 8 1500
MemPool 4096

Protocol TCPIP
# ip_router 192.77.203.?

ip_netmask 255.255.255.0
ip_address 192.77.203.66
tcp_sockets 8
udp_sockets 8
raw_sockets 1
nb_sessions 0
nb_commands 0
nb_adapter 0
nb_domain
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Ethernet NET.CFG
The following is an example of a NET.CFG file set up for Ethernet.  You
will need to customize this according to your installation.

Link Driver SMC8000
FRAME ETHERNET_II

Link Support
Buffers 8 1500
MemPool 4096

Preferred Server=[Server Name]
Protocol TCPIP

ip_router 192.77.204.61
ip_netmask 255.255.255.0
ip_address 192.77.204.65
tcp_sockets 8
udp_sockets 8
raw_sockets 1
nb_sessions 0
nb_commands 0
nb_adapter 0
nb_domain

Token Ring NET.CFG
The following is an example of a NET.CFG file set up for Token Ring.
You will need to customize this according to your installation.

Link Driver TOKEN
PORT A20
FRAME TOKEN-RING MSB
FRAME TOKEN-RING_SNAP

Link Support
Buffers 8 4094
MemPool 4096

Protocol TCPIP
# ip_router 192.77.203.

ip_netmask 255.255.255.192
ip_address 192.77.203.21
tcp_sockets 8
udp_sockets 8
raw_sockets 1
nb_sessions 0
nb_commands 0
nb_adapter 0
nb_domain
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Loading Network Drivers

The appropriate network drivers must be loaded in the correct sequence
in order for Total Control Manager/SNMP to send SNMP data to the
chassis.  TCP/IP may be loaded with either SLIP, Ethernet, or Token
Ring drivers.  These drivers can be loaded manually from the DOS
prompt, by creating a batch file, or, more conveniently, through
AUTOEXEC.BAT.

All drivers are provided in the C:\NMS\BIN\NET directory, with the
exception of the Ethernet and Token Ring drivers.  Be sure to copy these
drivers to whichever \NET directory you use.

SLIP Connection Example
Drivers must be loaded in the following order for a SLIP connection:

LSL
SLIP_PPP
TCPIP
DOSDIALR

Ethernet Connection Example
Drivers must be loaded in the following order for an Ethernet connection:

LSL
SMC8000
IPXODI*
TCPIP
NETX*

*  Only required on a Novell network.
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Token Ring Connection Example
Drivers must be loaded in the following order for a Token Ring
connection:

LSL
TOKEN.COM
IPXODI*
TCPIP
NETX*

*  Only required on a Novell network.

Unloading Drivers
It may be convenient to create a batch file that will allow you to unload
all the drivers.  Drivers must be unloaded in the exact reverse order from
how they were loaded.  The command line switch “-u” can be used to
unload the drivers.  For example, to unload the drivers for a SLIP
connection, you might create a batch file named KILLSLIP.BAT that
reads as follows:

DOSDIALR -u
TCPIP -u
SLIP_PPP -u
LSL -u
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Testing Connectivity

One of the first operations you will want to perform is to make sure that
you are communicating with the NMC.  This can be done in two ways:
from the DOS prompt, or from the NMS software.

From DOS
Installation of the software places the file PING.EXE in
C:\NMS\BIN\NET.  Type the following command from the DOS
prompt at that directory:

PING [IP ADDRESS]

You may also use the command line switch “-nX”, where X indicates the
number of times you want to repeat the operation.  The following
example pings the NMC at IP address 192.77.203.65 five times:

PING -n5 192.77.203.65

From NMS
1 Installation of the software creates an NMS Program Group in

Windows.  Open this group and double click on the NetWare
Management System icon.  The NMS screen appears.

2 From the Fault Menu, select the Test Connectivity option.  The
Connectivity Test window appears.

Figure 3.  NMS Connectivity Test
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3 Type in the IP Address that you have assigned to the NMC NIC port
you are using.

4 Click on the Test button.  This test is equivalent to performing a ping
on a network device.  If the software can communicate with the
chassis, a confirmation message appears in the Status box.

Troubleshooting with the LEDs
If you do not receive a satisfactory response from either of the two ping
methods, observe the LEDs on the NMC front panel.  With a SLIP
connection, you will need to observe the WAN RX and WAN TX LEDs;
LAN connections will be reflected in the LAN RX and LAN TX LEDs.

No LEDs
♦ There may be a bad physical connection.  Check the cabling, and

make sure that the correct port is being used on the NMC (CH2 for
SLIP, or a LAN port for Ethernet or Token Ring).

♦ The wrong PC COM port may be addressed physically, or specified
incorrectly within the NET.CFG file.  Check both the Port and the
Interrupt specified in this file.

♦ If a network adapter card is being used, there may be a problem with
the PC COM port addressing.

Only the RX LED Lights
♦ The ping may be reaching the NMC, but the wrong IP address is

being used.  Check that the IP address that you are typing is the one
that is set within the NMC RS-232 User Interface.  Unless you have
already changed them, default addresses are assigned to both the
LAN (192.77.203.193) and WAN (192.77.203.65) ports on the NMC
NIC.

♦ The baud rate may be incompatible.  Make sure that the baud rate
specified in your NET.CFG file is the same as the rate set with the
NMC DIP switches.

Switch Factory Setting Function

3,4 OFF, OFF NMC NIC Out-of-Band Management
(WAN) Port Rate
DIP 3 DIP 4 Selects
OFF OFF 9600 bps
OFF ON 19200 bps
ON OFF 38400 bps
ON ON 57600 bps
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♦ You may be trying to use a baud rate above 19.2 Kbps with a PC
COM port that uses an 8250 UART.  We recommend a 16550 UART
for higher speed connections.
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Loading Total Control Manager/SNMP

1 Load TCM from the NMS window by selecting Total Control
Manager from the View menu.

2 From the File menu of TCM, select New. . ..  The following window
appears.

Figure 4.  New Device Window

3 Assign a Device Name for the chassis.  This name will identify the
chassis in your management database.

4 Enter the IP address of the NMC NIC port (WAN or LAN) to which
you are connecting.  You should have set this address when you
installed the NMC.  If you set SNMP community strings when you
installed the NMC, set them here to match.

5 If you are dialing into the chassis, click on the Option button to enter
a phone number and set other Remote Communications options.

6 Click OK when you are satisfied with the information you have
entered.  The Virtual Front Panel Display (VFPD) of the chassis
appears.
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7 Once you have connected successfully to the chassis, select Save fron
the File Menu.  The device name and IP address are added to the
NMS database.

The Virtual Front Panel Display Window
Once a device has been added to the network database, it can be opened
from TCM by selecting Open... from the File menu.  When you open a
device, TCM discovers its configuration and opens the chassis display
window, which contains an interactive graphic representation of the
chassis you are connected with.

Figure 5.  The VFPD Chassis Display Window

A separate Display window appears for each chassis that you open.
However, only the active window displays updated LED information.
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Selecting a Device
Before applying any kind of configuration change, you must first select
the card(s) or channel(s) on which you want to take action.

The following graphic shows the "hot spots" on various cards for
selecting individual channels, software entities, or the card as a whole.

Selects Both DS1 Entities

Dual T1 Card

Quad Modem CardDual Modem Card

Network
Management

Card

Selects All 4 Modems

Selects Individual 
Modem Channels

Selects 
Entire
Quad Modem Card

Selects 
Entire
Single T1 Card

Any
Location
Selects
Entire
Network
Management
Card

Selects Both Modems

DS1-1 Selects
Individual
DS1 and DS0
Entities

Selects
Entire
Dual
Modem
Card

DS1-2

Selects Modem 1

Selects Modem 2

Selects Both Modems

Single T1 Card

Selects 
Entire
Dual T1 Card

Selects
DS1-1

Selects
Individual
DS1 and DS0
Entities

Figure 6.  Hotspots

♦ To select a single channel on a card (for instance, one modem on a
Quad Modem Card), click directly on the LED that represents the
status of that channel with the left mouse button.  The LED changes
color to indicate that it has been selected.
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♦ To select all channels on a card (for instance, all four modems on a
Quad Modem Card), click with the left mouse button on the RN/FL
LED (the top LED on all cards).  All the LEDs change color to indicate
that the channels are selected.

♦ To select an entire card, in order to perform an action on the card as a
whole, click with the left mouse button anywhere on the black area of
the card.  The whole card (all the LEDs and the background in that
slot) changes color.

♦ To select a range of objects across multiple cards, for example,
Modem 2 on four adjacent Quad Modem Cards, hold down the
CTRL button and click on each object with the left mouse button until
you have selected all that you want to include.

♦ To select all objects of the same type as a currently selected object,
choose the Select All option from the View Menu.  For instance, if
you currently have one channel of a Quad Modem Card selected and
you then choose the Select All option, all modem channels in that
chassis will be selected.

Using the Configuration Window
The Configuration window lets you set or query parameter settings for
the card you selected from the Display window.  Access the
Configuration window by selecting a card or LED hotspot from the
VFPD chassis display and choosing the Programmed Settings option
from the Configure menu, or click on the Configuration icon, which
shows a finger pointing at a chassis.

NOTE:  Faults are also configured from this window.  See Setting Traps
later in this guide.
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Figure 7.  The Configuration Window

The Selected Objects box displays the IP address of the chassis you are
configuring and the slot and channel of the card(s) you selected.  A
separate column for each card (the slot and channel number is displayed
in the column heading) allows you to change or view settings.

Different parameter groups can be selected from the Parameter Group
drop-down box.  The Total Control Manager/SNMP Software Guide
provides definitions for all the configurable parameters.

NOTE:  The Configuration window is a new feature as of release 3.1.
For more details on the Configuration window, see the Total Control
Manager/SNMP Software Guide or click on the window’s Help button.
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Using the Commands Window
The Commands window lets you send commands such as Software Reset
and Store to NVRAM to a any card in the chassis.  The range of
commands varies on the card.

Use the following steps to send a command to a modem or group of
modems:

1 Select the modems to which  you wish to send commands from the
chassis display (see Selecting Modems at the beginning of this section).

2 Select the Actions/Commands option from the Configure menu, or
click on the Action button on the toolbar (represented as a bolt of
lightning striking a card).

Figure 8.  Total Control Manager Commands Window

3 Choose a command from the Command to Execute drop-down box.
The Command Status window displays the selected device(s) that the
command will be sent to.  Click on the Execute button to send the
commands to the device(s).  Wait for the Last Exec Result field to
return the Complete message and the Result field to return the
Success message.

See Commands in the Total Control Manager/SNMP Software Guide for more
detail on the Commands window.
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Configuring Modems

Instead of sending AT commands to each modem, you can use Total
Control Manager/SNMP to configure one, several, or all of the modems in
a chassis.  The following description outlines how to set a chassis full of
modems to your desired settings.

Configure Modems with Desired Settings

1 Select one modem channel on the VFPD chassis display window.
Bring up the Configuration window using the Configuration icon or
by selecting Programmed Settings from the Configure menu.  The
modem identification information for that modem is displayed in
worksheet form.  Note the slot and channel number displayed in the
column heading (for example, S1C1).

2 Configure the modem with the desired settings.

3 After the desired configuration is complete, click on the Set button.
This loads the settings you selected from the Configuration window
to the modem.

4 Exit the Configuration window by clicking OK.  This returns you to
the chassis display.  The configured modem is still selected.

5 Select all the modems you wish to configure, using your left mouse
button and the CTRL key.  If you want to configure all modems in
the chassis, choose the Select All option from the View Menu.

6 Bring up the Configuration window again.  Click on the Load From
button.  Enter the slot and channel number of the modem you
configured in step 2.

7 Click on OK.  All the selected modems are programmed with the
settings of the modem you configured, and you are returned to the
Configuration window.  All the modems you just configured should
still be selected in the chassis display.  Keep them selected for the
next step.
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8 Optional.  Save configurations to NVRAM by executing the Store to
NVRAM command from the Commands window (see Using the
Commands Window).  If you do not complete this step, modems will return
to NVRAM defaults on power-on or reset.

Return the Modems to Default Values

1 Select one modem channel from the VFPD chassis display window.

2 From the View menu, choose Select All.

3 Either select Actions/Commands from the Configure Menu, or click
on the Action icon in the Toolbar (represented as a bolt of lightening
striking a card).  The Total Control Manager Commands window
appears.

Figure 9.  Commands Window

4 In the Command to Execute field, select the Command option
Restore to Default.

5 Click on the Execute button to send the command to all of the
selected modems.
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Saving Configurations

The Network Management Card has the power to save and restore all
the configurations of cards installed in the chassis.  Follow these steps.

1 Be sure that you have configured all installed cards to your desired
settings.

NOTE:  At this time, do not configure the NMC.

2 After the cards have been configured, save the card configurations to
NVRAM using the Action/Commands window (as described earlier).

3 Select the NMC from the chassis display by clicking your left mouse
button anywhere on the card.  Select Programmed Settings from the
Configure Menu, or click on the icon in the Toolbar.  The
Configuration window appears.

4 Select the Configuration Group.  Change the setting of the parameter
Auto Config on Card Initialization from Disable to Enable.  Click on
the SET button and exit the Configuration window.

5 With the NMC still selected, bring up the Action/Commands
window again and send the Save Chassis to NVRAM command to
the NMC.

The NMC now has stored in its NVRAM a snapshot of all the card
configurations.  Whenever a card is removed and then reinserted, or
when the chassis is powered off and then on again, these values are used
to configure the cards.  If a new card has been inserted into the chassis
that does not match what the NMC has stored and expects to find in a
particular slot, default values are used to configure the card.
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Monitoring Performance

Total Control Manager/SNMP allows you to query the status of cards
installed in the chassis.  This can be accomplished in the following ways:

♦ Viewing the LEDs that represent the card on the VFPD chassis
display.

♦ Selecting the LED Polling Information option from the View Menu.
This window gives you an idea of the frequency of LED polling, as
well as the number and nature of errors encountered.

♦ Launching the session monitor for a selected card or cards.

The Session Monitor
Once you have selected one or more cards, you can launch the session
monitor in two ways:

♦ Click on the Performance button at the far right of the Toolbar
(represented as a gauge, like a tachometer).

♦ From the Performance Menu, select Session Monitor.

The Functional Group Monitor Setup screen appears.

Figure 10.  Functional Group Monitor Setup
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Choose parameters from the Parameters list and Add them to the
Parameters Selected box.  You can add up to ten parameters at one time.
Select the desired polling interval, and click on OK to start the query
operation.  The Performance Table appears with the statistics you have
requested.

Figure 11.  Performance Table

Columns can be adjusted by clicking on the spaces between column
headings, as illustrated in the above figure.  The order of the columns can
also be adjusted by clicking and dragging column headers.
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Setting Traps

A trap is an SNMP message sent from a device to a Management Station
to signal that a specific event or fault has occurred in that device.  You
can set traps for a network device to trigger alarms in the Management
Station, or for Event Logging.

Traps may be configured (enabled/disabled) through Total Control
Manager/SNMP.  They allow the operator to detect, isolate, and correct
problems or events that occur with an object.

Configuring a Trap

1 Select the card(s) for which you want to set traps from the chassis
display window.

2 Select Trap Settings from the Fault Menu or click on the Fault icon in
the Toolbar (represented as a hand setting an alarm clock).  The
Configuration window appears.

Figure 12.  Modem Faults Configuration Window
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3 Enable traps.  Some parameters do not have the enableLog option.
These parameters can not produce traps for Account Logging.

Important:  Some fault parameters require that you set thresholds.
Use the context-sensitive online help to see if the parameter you
selected requires a threshold setting (with the parameter selected,
click with the right mouse button).  For instance, the Modem Event
Thresholds parameter group is used to set modem trap thresholds.

4 Click on the SET button and exit the Configuration window.

Configuring a Trap Destination
After you have configured Total Control Manager/SNMP to generate
traps, you can choose to send these traps to one or more Management
Stations.

1 From the Fault Menu, select Trap Destinations.  The Trap
Destination Table window appears.

Figure 13.  Trap Destination Table Window

2 Click on the Add button at the right side of the window.  The Add
Trap Destination window appears.

Figure 14.  Add Trap Destination Window
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3 Enter the following information:

♦ IP address of the trap destination

♦ SNMP Community String

♦ Annotation (any additional informative text)

4 Click on OK to accept the trap destination information.
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Configuring Alarms

Alarm is a generic term that refers to how a Management Station reacts
when it receives an SNMP trap.  Alarms are configured in NMS.

Before you can use alarms, you must do the following:

♦ Set traps for your devices.

♦ Integrate alarms into NMS.  The alarm integration procedure is
described earlier in this guide under Installation Adjustments.

Additionally, the Alarm Manager portion of the NMS must be running;
this software is launched automatically when you start the NMS.
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Configuring Alarm Notification
Once you have enabled a trap for an event, you can configure the type of
notification(s) that will be generated for that trap within NMS.

1 From the Fault Menu, select Alarm Disposition.  The Configure
Alarm Disposition window appears.

2 For the Family of alarms, select SNMP.  Then select the type of alarm
from the drop-down list box.

Figure 15.  Alarm Disposition

3 Under Configuration, choose settings from the drop-down list boxes
for the alarm severity and the object state for the affected object (such
as Operational or Degraded).  The object state is the condition you
expect the object to be in as a result of the condition that triggers the
alarm.  This in turn affects the displayed icon for the device.  For
instance, if you set the object state to Non-operational, the icon will
become “grayed out” to indicate a severe condition, but it can still be
selected.
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4 Select an action for the alarm disposition.  When an alarm occurs, you
may choose to log the alarm in the database, create an audible beep,
display a “ticker tape” message across the status line of the NMS, or
execute a program of your choice (such as USRBEEP.EXE, located in
the NMS\BIN directory).  When you have selected the appropriate
disposition(s), click the Save Configuration button at the bottom of
the window.

Monitoring Alarms
The Alarm Monitor is a real-time display of all alarms that have occurred
since you launched NMS, or since the last time the Alarm Manager was
restarted.

From the Fault Menu, select Alarm Monitor.

Figure 16.  Alarm Monitor

The Alarm Monitor fills the NMS screen, and is divided into the
following sections:

♦ The top pane contains pie charts representing the severity and family
of alarms generated.  All Total Control alarms are part of the SNMP
family.  This pane is updated every two minutes.

♦ The bottom pane contains nine columns of alarm information; the
most recent alarm is displayed in the top row of the table.  These
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columns contain the time that the alarm was received, the type of
alarm, the affected station, the alarm severity, the operational state of
the affected device, the network address of the affected device, the
station type of the affected device, the time that the alarm was sent to
the NMS, and an alarm summary.  Use the scroll bar at the bottom of
the table to view all of this information.

Generating Alarm Reports
The Alarm Report displays information about alarms that are logged to
the database.  This option is enabled in the Alarm Disposition window,
described earlier.

If no icons are selected in an internet map, the Alarm Report displays all
alarms.  If an icon is selected, the Alarm Report shows only those alarms
generated by the chassis represented by that icon.

The Alarm Report contains all the information presented in the Alarm
Monitor table, including the following fields:  a note that you have
entered about the alarm, an indication of whether or not the alarm has
been acknowledged, and the date and time that the alarm was
acknowledged.

The Alarm Report can be used for the following purposes:

♦ Acknowledge alarms.

♦ Delete alarms from the database.

♦ Print alarm information.

♦ Add a note to an alarm for a coworker.

♦ Find and display a device specified by a selected alarm on the
Internet Map.
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